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1 Introduction 
______________________________________________________________________ 
 
 
Thank you for purchasing the MALÅ GeoScience software Object Mapper 2018. Object Mapper is a Windows™ 
based visualization software for MALÅ GPR radar data.  
 
Object Mapper is developed to easily handle and interpret radar profiles acquired with the Object Mapper Option 
in the Easy Locator Pro, GX, CX or XV, where a number of radar profiles are linked to a common baseline or when 
measurements are carried out with a GPS for positioning. 
 
Object Mapper includes such features as the visualization of several radar profiles simultaneously, filtering of data, 
and a report editor to mark and visualize objects on a map (see images below). Several different types of markers 
can be defined to illustrate the position of pipes, discrete objects etc. 
 
 

Show a number of parallel lines… 
 

 

 
 

…pick the interesting features…. 
 

 

 
 
 

….from each of them… 

 
…. and instantly see the location of the mapped feature on the defined investigation area 

 

  
 
 
 
 
Object Mapper can also be used with previously acquired MALÅ GPR data profiles, as an Object Mapper project 
can easily be created within the Object Mapper software.  
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MALÅ GeoScience welcomes comments from you concerning your experience using the software, together with 
comments on the contents and usefulness of this manual. To help us deal with your comments, always include the 
software version number. 
 
MALÅ GeoScience postal address is:  
 
Main Office:                                           
MALÅ GeoScience AB                  
Skolgatan 11                          
S-930 70 Malå                          
Sweden                                                           
Phone:  +46 953 345 50                             
E-mail: sales@guidelinegeo.com             
    
North America:  
Guideline Geo America 
465 Deanna Lane, Charleston 
South Carolina 29492 USA 
Phone: +1 843 852 5021                    
E-mail: sales.usa@malags.com 
sales.usa@guidelinegeo.com             
 
Technical support requests can be sent to: support@guidelinegeo.com 
 
Information about MALÅ GeoScience’s products is also available on the internet: http://www.guidelinegeo.com 
 

 
 

http://www.guidelinegeo.com/
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2 Object Mapper Tutorial 
______________________________________________________________________ 
 
This Object Mapper tutorial will guide the user through the main steps in visualizing underground features, e.g. 
water pipes. As the program is started, the following screen is displayed: 

 

 
    
 

1. Main Screen for different views (Site Map and Data View, see Section 3.2 “View”) 
2. Main Menu (Chapter “Main Menu”) 
3. Toolbar (Section 3.2.1. “Toolbar”) 
4. Status Bar, information on profile, x- and y-coordinates etc. (Section 3.2.2. “Status Bar”) 

 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
3 

4 
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Start the mapping procedure by opening the Object Mapper project (created within MALÅ Easy Locator Pro, GX, CX 

or XV Monitor and saved as an *.obm file), by pressing  in the Toolbar or by using the command “Open” under 
the File menu.  
 
If using data files already acquired with Ground Vision or without the Object Mapper option in the Easy Locator 

Pro, GX, CX or XV Monitor, use the command “New” (-> File or ) and follow the easy steps in the Project Manager 
(see Section 3.2.5. “Project Manager” below) to create a new Object Mapper Project.  
 
As the chosen project is opened the following screen is seen:  
 

 
 

Or if the Object Mapper project is measured with the GPS option ON:  
 

 
 
 

Note: See Appendix 2 for information on GPS Measurements. 
To the left the Site Map is displayed, with the baseline (as defined in the Easy Locator Pro, GX, CX or XV Monitor or 
in the Object Mapper software itself) in orange (if the baseline option was selected in the Monitor) and all the 
associated radar profiles in green, blue or black. If the GPS option was selected (in the Monitor) the profiles are 
displayed without any baseline.  
 
In the right hand screen the radargrams are shown with the top radargram corresponding to the brown marked 
line on the Site Map. The green section of this brown line represents the visible part seen in the Data View 

window; this green highlighted section will move as the bottom scrollbar is dragged left or right in the 
radargram window. The visible radargrams are marked with blue colour on the Site Map.  

 
Up to ten radargrams can be displayed simultaneously, see section Options to find out how.  
 

The rolling wheel on the mouse can be used to scroll the radar data up and downwhen the Data View window is 

active.  
 
To enhance the data quality, a number of different filters can be applied to the radar data. See Section 3.3.2 "Edit 
Filter List" and Appendix 1 "Filters". 
 
Furthermore, the contrast of the radargram can be adjusted with the contrast scrollbar  at the 

top right in the Data View window, while the active filters can be turned on and off by pressing . 
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When processing data from the Easy Locator HDR PRO WideRange, click the  icon to switch between the high 
and low frequency channels.  
 

 Indicates the high frequency (HF) is active 
 

 Indicates the low frequency (LF) is active 
 
Note: this icon is only active when WideRange data is being processed. 
 

    
                                  Low frequency channel                     High Frequency channel 
 

Note: When a marker is placed in either of the HF or LF channel in the WideRange data, the marker will 
automatically be placed in the other channel. 
 
 
Use the “Reverse profile” option, if one of the viewed profiles needs reversing. In the example below, the top 
profile needs to be reversed, right click the profile to be corrected in the Site Map, and select the “Reverse profile” 
option. 
 
 

 
 

The direction of the profile will be corrected like so: 
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When measuring with the GPS option there are two ways of adjusting the display of the GPR profiles to make it as 
‘correct’ as possible. See example below, where the long profile (at right) is displayed together with two shorter 
ones. When right-clicking in the profile the options Directions of GPS profiles and Horizontal Alignment for GPS 
profiles can be selected. 
 

 
 

                                                                                    
Directions for GPS profiles, Horizontal or Vertical                           Horizontal Alignment for GPS profiles, Left or Right 

 
Note: Even with GPS, it is recommended to measure in parallel profiles, as this will enable the user to view several 
GPR profiles simultaneously and thus allow direct comparison of identified objects in different lines.  
 
The depth of a feature in the radargram is often required. To obtain this value, the radar velocity in the soil under 
investigation is required. Where the velocity cannot be calculated via other techniques, the hyperbola fitting tool 
can be used. 
 

Click the hyperbola icon  to activate the hyperbola fitting tool  
  
 

 
 
 
Next, place the mouse curser on the top of the actual 
hyperbolic reflection and right click to insert the 
synthetic (yellow) hyperbola 
 
 
 
 
 
 
Next, select “Change velocity” 
 
 
 
 
 

 
 
 

Then use the slider bar to increase or decrease the 
width of the yellow hyperbola, so it matches the width 
of the actual hyperbola. 
 
Note: if it is not possible to match the shape at the top 
of the hyperbola, use the “Change radius” option to 
get increase or decrease the width of the synthetic hyperbola. 
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When the desired width is achieved, move you mouse curser back 
over the yellow hyperbola, right click and select “Set current Velocity”. 
The value will be displayed in the Status Bar at the bottom of the 
display. 
 
When the hyperbola matching is complete, click the “Insert 
Hyperbola” icon again to de-activate the tool. 
 
Note: it is important that the selected hyperbola (for the fitting), is from a feature that is exactly perpendicular to 
the line of the profile, otherwise a false reading will be obtained. It is possible to change the angle value in the 
above dropdown box if the angle between the feature and the profile is known. 
 
 
When the radar data are fully processed, the interpretation of objects/features can be started. To do this, click on 

one of the seven different marker types in the Data View window . See Section 3.4 “Tools” to 
explore how these are defined.  
 
After clicking on one marker type the mouse pointer changes to a cross which can be placed on an identified 
hyperbola in the different radargrams.  

 
 
Note: The marker function is inactivated by pressing the marker type on toolbar again.  
 
Markers can also be placed by right clicking on the correct position on the radargram and then choosing “Insert 
marker” from the pop-up menu (see below).  
  
If a marker is activated (with left mouse click) a rectangle is seen around the marker and it can be moved by drag-
and drop; when right clicking on the marker a pop-up menu appears as seen below.  
 
Important note! The markers in the Toolbar must be inactivated; otherwise new markers will be will be set when 
attempting to select existing cross-hairs.  

 

 
 
Several markers can be marked/activated simultaneously, by keeping the “Ctrl”-button on the keyboard down. 
Also see information on Marker lists in Section 3.2.3 “Marker list” 
 
The “Edit marker” function enables manual input of the location of the marker and change of object type. A 
comment can also be made, see below. The “Edit marker” function is also reached by double-clicking on the 
marker.  
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To work and browse through all the files, click on the different radar profile lines on the Site Map. The selected 
profile will turn green and show up as the top radargram in the Data View window.  
 
When all interesting features are identified, the project is saved and the resulting map, as shown below, can be 
printed immediately or exported in AutoCad dxf-format; see below. All the markers are also listed (as seen in 
Section Markers) and can be exported in ASCII-format with the correct position and depth. 
 
Note! The marker to be exported MUST be marked in the marker list, prior to export. For more information see 
Section Markers 3.2.3 “Marker List”. 
 

 
 

In the above example, the colours of the markers can, for instance, represent different depths or different types of 
identified structures. 
 
Finally, if measurements have been taken in a grid pattern, these two projects can be combined into one, as in the 
example below. This makes the interpretation work much simpler. Choose the option “Add project” in the File 
menu to combine two projects. This option is available both when measuring with the baseline option and with 
the GPS option. 
 
Projects close to each other in different directions can be gathered on the same site map.  
 
Note: The same coordinate system must be used to define the baselines of the radar profiles or the GPS position.  
 
Note: When editing the properties of projects with several baselines, mark the baseline to be edited in the Project 
Manager.  
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3 Main Menu 
______________________________________________________________________________ 
 
 

          The Main Menu of Object Mapper is found on the top of the screen.     
 
 

3.1 File  
 
In the File menu the Object Mapper projects can be created, opened and saved. It also contains the print 
functions. 
 

New: Creates a new project. See Section
 3.2.5 “Project Manager” below. 
Open: Opens an existing project. 
Close: Closes an opened project. 
Save: Saves an opened project using the 
 same file name. 
Save As: Saves an opened project to a 
 specified file name. 
Export: Exports the resulting map, with  
 markers to DXF-format, markers to 
 ASCII-format lists or to MALÅ GPS 
 Mapper format. Note! The markers 
 to be exported must be selected 
 in the Markers list. 
Add project: Adds another project to the existing 
 one. 
Print: Prints the current view. 
Preview: Displays the document on the  screen, 
as it would appear printed. 
Print Setup: Selects a printer and printer 
 connection. 
Exit: Exits the application. 

 

 

 
For the Export option to *.dxf, the different marker types on the map are exported to separate layers.  
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3.2 View  
 
 
The menu View shows the different views and tools that can be 
shown on the screen. 
 
 

 
 

 

3.2.1 Toolbar 
The Toolbar is displayed across the top of the application window, below the Main Menu bar. The Toolbar provides 
quick mouse access to some of the tools used in Object Mapper. 
 

                                                             
Create a new project 
        Open an existing project          About Object Mapper 

Save the active project  
                 Print the active view (Site Map or Data View) 
   

3.2.2 Status Bar 
The Status Bar describes the commands activated by pressing the selected button in the different menus or 
toobar. It also shows details of the active profile, as well as information on mouse position in the different 
radargram or Site Map views. Examples of the Status Bar are shown below. 

 

       
 
  Position of the mouse curser in the Data View window           Position of the mouse curser in the Site Map window 
  

 
 

3.2.3 Marker list 
In the marker list, all the identified and marked features are 
saved, according to their type and position.  
 

 

 
 

By right-clicking on one of the markers, the marker can be 
edited or deleted. It is also possible to choose to hide or 
select the marker (singly, by type or all together). 

 
 
 
With the option Export (in the Main menu) this list with selected markers can be exported to ASCII-format, where 
all marked objects are listed together with type, trace-, sample-, x-, y- and z-position.  
 
Note: The marker information also can be exported in DXF-format or to MALÅ GPS Mapper format. 
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3.2.4 Site Map 
When this option is chosen, the Site Map, with the different 
measured radar profiles, is displayed on the screen.  

 
The small rectangle on one end of the profiles (black, green or 
blue lines) shows the start point of the measured radar profile. 
 

                                
 

  

Site Map View Icons: 
 

         Change Longitude/Latitude coordinates to UTM 
Default view settings              Zoom level 

                                                                                                       

                                                        
 
Horizontal or vertical fit                          Show/Hide grid 
                                     Zoom, in or out Show/Hide scales 
 
The map coordinate system can be turned left or right handed in the Tools Menu, see Section 3.4 “Tools”. This 
option is only available for Baseline projects. 
 

3.2.5 Project Manager 
In the Project Manager a new project can be defined and the properties of current projects can be edited. The 
option General defines a simple baseline and evenly sorted profiles, while the option Advanced is used to define 
the baseline and every single profile in detail. Note! These options are only available for the Baseline project type. 
 
If viewing the Project Manager within an existing Object Mapper project, the project manager window displays the 
baseline and the radar profiles included. The settings in an existing Object Mapper Project can be changed as 
described below.  
 

 
If a new Object Mapper Project is desired (with profiles acquired 
with EL PRO, GX or XV Monitor but not in an OBM project), open 
the Project Manager and press  under the Baselines 
window and then to add the profiles associate with that baseline 
using the button beneath Profiles window. 
 
If the data were collected without baseline but with GPS, the 
Project Type is changed to GPS support and then only the option 
Add profiles is available.  

 
 

 

If WideRange data have been collected,  
click and check the Widerange option 
 
 
For both project types, Baseline or GPS, the location and name of the new project is given in the top line. 
 
 
Note: The project should be saved at the same location as the added radar profiles are situated. The possibility to 
browse between different folders to find an existing project is also available. 
 
Several profiles can be added simultaneously by using “Ctrl” on the keyboard. The sequence of the radar profiles 

can be changed by “drag and drop” in the profiles list. If new files are added later on these are added, by default, 
in alphabetical order but can then be re-arranged manually.  
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Note: When editing the properties of projects with several 
baselines, mark the baseline to be edited in the Project Manager 

 option 
 

 
 
 
With the option  the layout of the profiles can be defined with: 
 
- Equal interval for all profiles 
- Profile offset direction increasing to the left or right of the baseline 

(see picture below).  
- Every second profile’s data reversed. 
 

 
 
 

If the option “Profiles measured to the right of baseline start” is 
chosen the Site Map will be made as: 
 
Note: The start point of the Baseline is set to X=0 and Y=0. 

 
 

If the option “Profiles measured to the left of baseline start” is 
chosen the Site Map will be made as: 
 
Note: The start point of the Baseline is set to X=0 and Y=0. 

 
 

1st 2nd 

1st 2nd 
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The baseline and the radar profile location can also be defined in 

detail by choosing   
 
To reverse every second profile make sure that both options; 
“Recalculate directions for profiles” and “Every second profile 
has opposite direction”, is marked.  

 

 
 
Here the baseline can also be given geographically correct coordinates, in meter-format.  
 
For definitions of the different parameters of the radar profile location, see picture below. 
 
 

 

 

1

3

1

24

Baseline end

Measured

GPR Profiles

Baseline

start 

1

3

1

24

Baseline end

Measured

GPR Profiles

Baseline

start 

 
1: Orientation to baseline start point. In this case it is 270 degrees. 
2: Distance from the start of the current profile to the baseline 
3: Distance from baseline start to the current profile 
 

The Properties dialog can also be reached by right clicking on the radargram lines in the Site Map window.  
 
 
 
 

The example gives an angle of 270 degrees to the 
baseline start point. If the profiles are measured 
from right to left the angle to the baseline start 
point should be set to 90 degrees. 

 

 

 
         Baseline start 
         (X=0, Y=0) 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

1st 

2nd 

3rd 

and so on 
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3.3 Profile      

 
 
 
The Profile menu handles the colours and filters for the displayed radargrams.   

 
 
 

 
3.3.1 Change Palette 
“Change Palette” opens the Palette Manager where the possibility to change the 
colour scheme from black/white to colour is available. 
 
The palette shows the current colours for the open radargrams. To change single 
colour values, just double click on them. The operator can also change a 
spectrum of colours, by using the command “Interpolate”, after having changed 
two colours. It is possible to select a number of colours and interpolate between 
them. 
 
 
 
Here, three colours have been selected and interpolated: red - grey - blue  
 
 
 
 
The command “Load Palette” will open previously designed and saved palettes. 

 

  
 

3.3.2 Edit Filter List 
The option “Set Filters” under the Profile menu will open the Filter 
Manager.  
 
Here the operator can choose which filters and processing steps he/she 
wants to apply on the radar data, and also modify the settings of these.    
 

 
Note: See also Appendix 1 for more information on filters. 

 
Filters available  Shows the available Object Mapper software filters.  
 
Filters applied This box will list the current filters applied to the radar data. To edit the filters applied, 

mark the filter with the mouse and press Edit, or double-click.   
Add Add is used to add marked filters from the Filters Available list. 
Remove Press remove to take away marked filters from the Filters Applied list.  
 

The created filter list can be saved with   

and used again later by  
 
When viewing data, the command Ctrl+F will disable all filters at once; pressing Ctrl+F again the filters 
are turned on.  
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3.4 Tools 
 
In the Tools menu the operator can change the settings of the Site Map and Data View 
windows. For instance, the operator can choose between meter and feet as 
measuring unit, how the coordinate system on the Site Map should be arranged, how 
many parallel profiles to display simultaneously and what velocity should be applied 
for the depth scale. Furthermore the different marker types can also be defined here. 
In the Dialog Options the following tabs can be found: 
 

General Tab 
 

Here an example is given of the two map coordinate systems for the same project; 
left handed (at left below) and right handed (at right below).  
 
The user can chose to use the project name when the Site Map is printed or on own 
defined name.  
 
By using “Export to DXF” the coordinate order can be changed to have Eastings or 
Northing first 
 

        

 

 

 

 

 

 

 

GPR Profiles Tab 
 

“Maximum number of profiles” refers to how many profiles will be shown at the 
same time in the Data View window.  
The first arrival is set as a number of samples and defines the 0-level (ground 
surface). The first arrival can also be changed and set by clicking on the red 
triangles in the Data View and “drag and drop” to the correct position.  
The correct ground velocity can be manually entered.  
The GPS antenna height can be entered, measured from the ground to the 
geometric centre of the GPS antenna 
The vertical scale can be changed to either Depth or Time. 
The “Sort order” refers to the order of the radargrams in the GPR Profiles view.  
Radar Data Size refers to the type of data file to be used. Older .rd3 data files are 
16 bits and the newer .rd7 files are 32 bits. We recommend Autodetect is selected, though manual selection of 16 
or 32 bits may be required occasionally. 

 

Markers Tab 
 
Your own definition of marker types can be noted. These descriptions are also seen in 
the Marker List and are included in the export to DXF and ASCII-format lists.  

 

 

 

 

Here is an example of the two map coordinate 
systems for the same project; left handed (X 
up, Y right) and right handed (X right, Y up) 
respectively.  
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Appendix 1 
 Filters 

____________________________________________________________________________________ 
 
 
 

This appendix covers the available filters in the Object Mapper 
filter manager. Any filters that have user-definable settings 
will have a dialog connected to them. This dialog can be called 
from the “Filter Manager” and is shown in each filter 
description, below. Common to all filter dialogs is the trace 
window that shows the filtered trace. The trace window is 
updated when there is a change in the filter settings.  

 
 

Which filter to use is will depend upon the application and the quality of the radar image. A filter very useful for 
some applications can be useless in others. The knowledge and experience of the user often determines the time it 
takes to produce a useful image. A general recommendation is to start with some form of DC filter and Gain. Below 
the available filters are listed and also if they are always, often, seldom or very seldom used in common GPR 
applications.   
 
Always used: DC Adjustment or FIR 
 
Often used: Delete Mean Trace, Time Gain, AGC 
 
Seldom used: Custom Gain, Moving Average, Moving Median, Threshold 
 
Very seldom used: Average, Median, Triangular FIR, HFIR 
 
 

Automatic gain control (AGC) 
This filter attempts to adjust the gain of each trace by 
equalizing the mean amplitudes observed in a sliding time 
window. A short window gives a more pronounced effect, the 
extreme of which would be a one-sample window, which 
would cause all amplitudes to be equal. The other extreme 
would be a time window of the same length as the trace; this 
would have no effect on the trace. After equalization a 
constant multiplier is applied to the trace to make the 
resulting amplitudes reasonable.  

 
 

 
Average 
The Average filter calculates a mean over a given number of 
samples and traces. The sample in the middle of the grid is 
replaced by the average value. This filter acts as a simple 2D-
lowpass filter and gives a softer picture. 
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Custom Gain  
An amplifying filter where the gain factor is given manually for 32 
different sections of the trace. Click and drag the small squares in 
the right window until the desired level is reached. 
 

 
 
DC Adjustment 
There is often a constant offset in the amplitude of the 
registered trace, this is known as the DC level or the DC offset. 
This filter removes the DC component from the data. The DC 
component is individually calculated and removed for each 
trace. 
 
In the dialog the sample interval on which the DC component is 
calculated is specified. Values for the start and end samples can 
be entered in the edit boxes or by click-dragging in the trace 
view. The sample interval is shown as a red area in the trace 
view. 

 
 
Delete mean trace 
This filter is used to remove horizontal and nearly horizontal 
features in the radargram by subtracting a calculated mean trace 
from all traces, sample by sample. The mean trace can be 
calculated for the whole profile or for a specified section of the 
profile. 

 
 
FIR 
A quick band-pass filter, working with a combination of two 
boxcar (averaging) filters. The filter is run in two stages. First the 
lower frequencies are attenuated by subtracting the average in 
the longer boxcar from the raw data at the centre of the boxcar. 
Then the higher frequencies are attenuated by replacing each 
sample with the average calculated in the shorter boxcar.  
 
Both boxes calculate along the whole trace.   

 
HFIR 
The HFIR filter functions as the FIR filter, but the filter runs 
along the profile - not along the trace. The filter is a spatial 
band-pass filter and its effect is similar to that of the 
background removal filter 
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Median 
The Median filter functions as the Average filter but, instead of the 
mean value, a median value is used. It removes spikes in the data 
efficiently while not blurring the image quite as much as the average 
filter does.  
  
 
 

 
 
  
 
Threshold 
All samples with a value below the threshold are set to zero.  
 
 

 
 
Time-Gain Filter 
The Time-Gain filter applies a time-varying gain to compensate 
for amplitude loss due to spreading and attenuation. The trace is 
multiplied by a gain function combining linear and an 
exponential gain, with coefficients set by the user. In the Time-
Gain dialog, there is one trace window and one gain window. The 
trace window shows a filtered trace and the gain window shows 
the gain function applied.  

 
The red line in the trace window indicates the start of the filter  
(before this point the gain of the filter is unity). 
 
 
Triangular FIR  
The Triangular FIR filter functions as the FIR filter, but instead of 
using boxcar averages it uses averages in symmetrical triangular 
windows.  
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Appendix 2 
 GPS Measurements 

_____________________________________________________________________________________________ 
 
 
This appendix covers some important issues when using a GPS to position the GPR measurements.  
 
The MALÅ Easy Locator Pro and GX can be used together with GPS equipment which communicates via a 9-pin 
serial connector. The GPS must communicate with NMEA 0183 protocol with GGA sentence. The built GPS can be 
utilized if required, though the positioning of the internal GPS is lower resolution, a RTK GPS will provide the 
highest resolution. 
 
The GPS equipment available today can be divided into three different types: 
 
GPS: Relatively inexpensive, the GPS is using only satellites for positioning, accuracy around ± 4 m. Suitable for 
large scaled layer mapping etc. 
 
DGPS: Differential GPS, uses satellites and a correction from the SBAS reference station/satellite network, accuracy 
around ± 0.5-2m. 
 
RTK GPS: Real Time Kinematic GPS, either uses two GPS receivers (one stationary base and one rover), or a single 
rover unit with RTK corrections received via a GSM connection; accuracy for both is around ±1-2cm.". RTK GPS 
accuracy is recommended for utility mapping. 
 
For all the three different GPS systems the following is very important to remember:  
 
1) Regardless of the system used; GPS, DGPS or RTK, the positioning data gathered will be of bad quality if the 
measurements are made under bridges, in dense forest, close to high buildings etc. In the example below the 
lowermost line is measured 1 m from a building, resulting in incorrect positioning of that measurement line.  
 

 
 
2) When using a GPS in motion, the GPS system is updated at different rates. Inexpensive systems may update 1 
time/second while RTK systems can update 10 or more times/second.  
 
 
3) The GPS antenna should be placed on the middle of the GPS antenna to 
give the most correct position of the GPR traces. This will be a problem 
when measuring with the MALÅ Geoscience RT antennas, and should be 
corrected afterwards.  
 
 
4) It should be observed that during the day the connection to satellites can 
change, giving better or worse positioning capability.  

 



www.guidelinegeo.com 
22 

Appendix 3 
Software license 

_____________________________________________________________________________________________ 

 
After installation of software, time limit license will be set for evaluation period. 
 
When this time has expired, purchase of the license is required to continue the use of the software. After the time 
license has expired, the program will only open the demonstration project. 
 
Object Mapper is only available in a hardware license format. 
 
Hardware licensing uses a license stored on a special USB device (called a USB dongle). This type of license can be 
used on any computer with the Object Mapper software installed. 
 
Contact MALÅ Geosciences on how to acquire a new license/hardware key. 
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Appendix 4 
Beginners Guide to Post Processing 

_____________________________________________________________________________________________ 

 
Introduction 
 
One of the most difficult things for a beginner to know, is “where do I start with the filters and what parameters 
should I use”. When it comes to data processing, every situation will be different due to the infinite differences in 
the soil conditions, user settings, antenna frequency and variety of other reasons. This short guide is for those who 
are not sure where to start and need a little help with their processing. 
 
The following two routines are based on average soil conditions in the application of utility detection with HDR 
data; description of the filter is, can be found in Appendix 1. Please use the following guidance with caution, taking 
into consideration that for utility detection we are attempting to emphasize particular response types and, as such, 
the filtering presented will not be suitable for all applications and environments. If you are unsure about filtering 
and processing of data, always seek further help from experienced users or available GPR literature and consider 
that, in most cases, less-is-best. Every processing step risks removing useful information from the data or 
introducing 'artefacts' which are responses not resulting from real features but the applied processing routines. 
Seek further help if you are unsure. 
 

 

Routine 1 - Semi-automated 
 
1. Move the mouse icon into the data, right click and select Filters, the Filter Manager will be opened. 
 

                            
 
 
 

2. Select FIR and Add 
 

 

There are 2 parameter values to choose here: 
 
Background removal  
The default value is 15, try this value and see how the data 
look; you can increase this value to 20 or 25 if needed, 
never decrease below 15. 
 
Lowpass 
Leave this parameter set at 5, vary rarely does this need to 
be changed. 
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3. Click OK and you will go back to the Filter Manager. You can either continue adding further filters at this point or 
you can click OK on the Filter Manager window to see what effect the filter you have selected has had on the data 
 
 
4. Now we need to add a level of gain and in this routine we will try AGC. From the Filter Manager, now click on 
AGC and this widow will open. 
 

 
 
 
 
5. Click OK in the AGC window and OK again in the Filter Manager, to see the results of these 2 applied filters. 
 

6. Often the contrast  will need to be changed at this point, use the slider to increase 
or decrease the contrast value, move until the desired level is reached. 
 
Tip: If you need to change any of the values in any of the filters, go back into the Filter Manager, click once on the 

filter in the Applied Filter box (on the right hand side), then select  
 
7. Another filter to try at this stage is the Delete Mean Trace filter, go back into the Filter Manager, select and add 
Delete Mean Trace. 
 

 
 
 
 
 
 
 
 

Again there are 2 parameter values to choose here: 
 
Scale 
The default value is 5000, reduce this value to 500 and 
see how the data look; you can vary this value (after 
changing the parameter below) from 300 to 700 if 
required. 
 
Window Size 
The default value is 21, change this value to 50 and, 
once again, see what the data look like. This value can 
be changed from 30 to 100. 

Make sure the  box is ticked/checked and 
click OK. 
 
 
8. Click OK in the Filter Manager Widow to see how this has 
affected the data. Most of the first arrival (the upper 
banding in the data) will be removed. 
 
 
Caution: Any horizontal reflections parallel to the surface 
will be removed from the data. These horizontal reflections 
could come from a pipe that is in the same direction as the 
profile. Use this filter with caution. 
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Here is a data set with the above filters applied one by one 
 

 
                Raw Data                                   FIR Applied                             AGC Applied 

  
     Delete Mean Trace Applied              Contrast Adjusted 
 
 
 

 
 

Routine 2 – Manual 
 
This routine will need more trial and error than Routine 1; don’t be afraid to experiment with the values.  

 
1. Open the Filter Manager, select FIR and Add, using the same parameters as above (Routine 1, step 1). 
 
2. Next add Time Gain. 
 

 
 
 

3. Add the Delete Mean Trace filter, the same as Step 7 in Routine 1. 
 
4. Click OK in the Filter Manger and see how the data look, remember to change the contrast value if needed. 
 
5. More amplification may be required to increase the strength of weak reflection towards the bottom of the data 
in the data (deeper utilities). This is often referred to as increasing gain lower down in the time window. 
                         
 

Note: you can stop at any point 
along these stages, though we 
recommend the FIR is applied as a 
minimum 

There are 3 parameter values to choose here: 
 
Start Sample 
First try an approximate value of 30. You can click in 
the left hand trace widow to move the red line. The 
value will change in the Start Sample box. 
 
Linear 
This value can vary over a very large range and a “trial 
and error” approach may be required. Try starting 1000 
and then increase if needed, some big steps may be 
needed. 
 
Exponential 
Again, this value can vary, try starting at 10 and 
increase if needed 
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Additional gain 
 

 
 
 

6. Back in the Data View, adjust the contrast , if required. 
 
 
 
Here are the results of this alternative processing flow on the same data set. 
 

 
                 Raw Data                                 FIR Applied                       Time Gain Applied 
 

                     
                      Delete Mean Trace Applied          Second Time Gain Applied 
 
 

Choose Routine 1 or 2 depending on your personal preference. Now you are ready to interpret the data and insert 
the markers, good luck! 
 
 

For further help and assistance, please contact your local dealer, MALÅ office or representative. Also refer to the 

contact details on Page 5 of this manual. 
 

There are 3 parameter values to choose here: 
 
Start Sample 
In this example, the start sample was moved to 81, this 
will often vary and "trial and error" will be needed. 
 
Linear 
This value was set to 10, you could increase this to 100 
or higher if needed. 
 
Exponential 
Again, this value can vary, try starting at 10. 
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